
 2013-2014 Microchip Technology Inc. DS50002113B

MCP19110/11/18/19 – Buck Power
Supply Graphical User Interface

User’s Guide



DS50002113B-page 2  2013-2014 Microchip Technology Inc.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicitly or otherwise, under any Microchip
intellectual property rights.

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
intended manner and under normal conditions.

• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2009 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT  SYSTEM 
CERTIFIED BY DNV 

== ISO/TS 16949 == 

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC, 
FlashFlex, flexPWR, JukeBlox, KEELOQ, KEELOQ logo, Kleer, 
LANCheck, MediaLB, MOST, MOST logo, MPLAB, 
OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, 
SST, SST Logo, SuperFlash and UNI/O are registered 
trademarks of Microchip Technology Incorporated in the 
U.S.A. and other countries.

The Embedded Control Solutions Company and mTouch are 
registered trademarks of Microchip Technology Incorporated 
in the U.S.A.

Analog-for-the-Digital Age, BodyCom, chipKIT, chipKIT logo, 
CodeGuard, dsPICDEM, dsPICDEM.net, ECAN, In-Circuit 
Serial Programming, ICSP, Inter-Chip Connectivity, KleerNet, 
KleerNet logo, MiWi, MPASM, MPF, MPLAB Certified logo, 
MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code 
Generation, PICDEM, PICDEM.net, PICkit, PICtail, 
RightTouch logo, REAL ICE, SQI, Serial Quad I/O, Total 
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, 
WiperLock, Wireless DNA, and ZENA are trademarks of 
Microchip Technology Incorporated in the U.S.A. and other 
countries.

SQTP is a service mark of Microchip Technology Incorporated 
in the U.S.A.

Silicon Storage Technology is a registered trademark of 
Microchip Technology Inc. in other countries.

GestIC is a registered trademarks of Microchip Technology 
Germany II GmbH & Co. KG, a subsidiary of Microchip 
Technology Inc., in other countries. 

All other trademarks mentioned herein are property of their 
respective companies.

© 2013-2014, Microchip Technology Incorporated, Printed in 
the U.S.A., All Rights Reserved. 

ISBN: 978-1-63276-703-5



VP Development Tools

Object of Declaration: MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In
 2013-2014 Microchip Technology Inc. D50002113B-page 3



MCP19110/11/18/19 – Buck Power Supply Graphical User Interface User’s Guide
NOTES:
D50002113B-page 4  2013-2014 Microchip Technology Inc.



MCP19110/11 – BUCK POWER SUPPLY
GRAPHICAL USER INTERFACE USER’S GUIDE
Table of Contents 
Preface ........................................................................................................................... 7
Introduction............................................................................................................ 7

Document Layout .................................................................................................. 7

Conventions Used in this Guide ............................................................................ 8

Recommended Reading........................................................................................ 9

The Microchip Web Site ........................................................................................ 9

Customer Support ................................................................................................. 9

Document Revision History ................................................................................. 10

Chapter 1. Product Overview
1.1 Introduction ................................................................................................... 11
1.2 The Development System’s Components .................................................... 12
1.3 Role of Firmware .......................................................................................... 13

1.3.1 Initialize the Internal Peripherals ............................................................... 13
1.3.2 Handle Protection Events .......................................................................... 13
1.3.3 Soft-Start Ramp ......................................................................................... 13
1.3.4 Environment Monitoring ............................................................................ 13

1.4 Graphical User Interface (GUI) Environment ............................................... 14

Chapter 2. Installation and Operation
2.1 Getting Started ............................................................................................. 15

2.1.1 Required Software ..................................................................................... 15
2.1.2 Required Hardware ................................................................................... 15
2.1.3 Software Installation .................................................................................. 15

2.2 Project Configuration .................................................................................... 22
2.3 Plug-In Features ........................................................................................... 25

2.3.1 MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In 
Description ............................................................................................. 25

2.3.2 MPLAB X IDE Actions ............................................................................... 26

2.4 GUI Tab Descriptions ................................................................................... 28
2.4.1 Parameter Tab .......................................................................................... 28
2.4.2 Components Tab ....................................................................................... 31
2.4.3 Efficiency Tab ............................................................................................ 32
2.4.4 Protection Tab ........................................................................................... 33
2.4.5 Compensation Tab .................................................................................... 34

2.5 Advanced Mode ........................................................................................... 36
2.5.1 New MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 

Plug-In Actions for Advanced Mode ...................................................... 36
2.5.2 Bench Test Tab ......................................................................................... 37

2.6 How Can the Code Be Modified? ................................................................. 38

Worldwide Sales and Service .................................................................................... 40
 2013-2014 Microchip Technology Inc. DS50002113B-page 5



MCP19110/11 – Buck Power Supply Graphical User Interface User’s Guide
NOTES:
DS50002113B-page 6  2013-2014 Microchip Technology Inc.



MCP19110/11/18/19 – BUCK POWER SUPPLY
GRAPHICAL USER INTERFACE USER’S GUIDE
Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In. Items 
discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP19110/11/18/19 – Buck Power Supply 
Graphical User Interface Plug-In as a development tool to emulate and debug firmware 
on a target board. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In. 

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with the MCP19110/11/18/19 – Buck Power Supply Graphical User Inter-
face Plug-In and a description of the user’s guide.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2013-2014 Microchip Technology Inc. DS50002113B-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50002113B-page 8  2013-2014 Microchip Technology Inc.



Preface
RECOMMENDED READING

This user's guide describes how to use the DSTEMP. Other useful documents are 
listed below. The following Microchip documents are available and recommended as 
supplemental reference resources.

• MCP19110/11 Data Sheet – “Digitally Enhanced Power Analog Controller 
with Integrated Synchronous Driver” (DS20002331)

• MCP19118/19 Data Sheet – “Digitally Enhanced Power Analog Controller 
with Integrated Synchronous Driver” (DS20005350)

• MCP87018 Data Sheet – “High-Speed N-Channel Power MOSFET” 
(DS20002329)

• MCP87050 Data Sheet – “High-Speed N-Channel Power MOSFET” 
(DS20002308)

• MCP19111 User’s Guide – “MCP19111 Evaluation Board User’s Guide” 
(DS50002109)

• MCP19110/11 Programming Specification – “MCP19110/11 Flash Memory 
Programming Specification” (DS20002336)

• MCP19118/19 Programming Specification – “MCP19118/19 Flash Memory 
Programming Specification” (DS20005321)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, and Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support.
 2013-2014 Microchip Technology Inc. DS50002113B-page 9
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DOCUMENT REVISION HISTORY

Revision B (December 2014)

• Added MCP19118/19 documentation to “Recommended Reading”.

• Added Section 2.3 “Plug-In Features”.

• Updated Section 2.4 “GUI Tab Descriptions”.

Revision A (March 2013)

• Initial Release of this Document.
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MCP19110/11/18/19 – BUCK POWER SUPPLY

GRAPHICAL USER INTERFACE USER’S GUIDE

Chapter 1.  Product Overview
1.1 INTRODUCTION

The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In is a 
stand-alone, hybrid (analog + digital), synchronous buck Pulse-Width Modulation 
(PWM) controller for point-of-load (POL) applications. It offers the ability to adjust many 
key attributes of the analog PWM controller’s operation. While at first it may seem that 
adjusting and configuring the product performance and feature set may be a challenge, 
it was with this in mind that the MCP19110/11/18/19 MPLAB X Plug-In was developed. 
This graphical user interface (GUI) simplifies the configuration of the controller and 
power conversion system and enables users to get to solutions faster.

The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface User’s Guide 
explains how to install and use the plug-in.

FIGURE 1-1: General System Diagram.

To summarize, the MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 
Plug-In is used within the MPLAB® X Integrated Development Environment (IDE). No 
knowledge of the MPLAB X IDE is required but, as the user becomes more familiar with 
Microchip's software tools and device performance, the MPLAB X IDE offers a path to 
support more advanced control algorithms and configurations.
 2013-2014 Microchip Technology Inc. DS50002113B-page 11
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1.2 THE DEVELOPMENT SYSTEM’S COMPONENTS

1. MCP19110/11/18/19 MPLAB® X IDE Graphical User Interface Plug-In: This 
graphical user interface simplifies the configuration of the MCP19110/11/18/19. 
It is user-installed and resides within the MPLAB X IDE. This user’s guide 
describes the plug-in installation procedure, as well as how to use it.

2. MPLAB® X Integrated Development Environment (IDE): This is a complete 
software development environment that links the software and hardware 
development. This is a free tool, available from Microchip, that supports device 
configuration, advanced programming, as well as debug support. The GUI 
resides inside the MPLAB X IDE.

3. MCP1911X – Power Supply Firmware: This firmware is provided by the plug-in. 
See Section 2.3.1 “MCP19110/11/18/19 – Buck Power Supply Graphical 
User Interface Plug-In Description”. This is standard firmware that has been 
configured to work with this graphical user interface once it is opened as a project 
within MPLAB X IDE.

4. MPLAB® XC8 Compiler: The firmware described above is coded in C and thus 
requires a C-compiler. C-compilers are available for free from Microchip's 
website.

5. MCP19111 – Power Supply Evaluation Board: This board is available from 
Microchip and provides a method to evaluate the performance of the MCP19111 
in the target end application.

6. PICkit 3 In-Circuit Debugger/Programmer, etc.: A programming tool is 
required to configure the evaluation board. We recommend the PICkit 3 or ICD3, 
which is available from microchipDIRECT.

In practice, the user modifies the GUI parameters to provide the features and 
performance needed in the end applications. The GUI modifies the firmware, compiles 
it with the XC8 C-compiler and then loads it, through the PICkit 3, to the MCP19111 
Evaluation Board. The MCP19111 Evaluation Board will then perform as configured.
DS50002113B-page 12  2013-2014 Microchip Technology Inc.



Product Overview
1.3 ROLE OF FIRMWARE

This section gives a brief overview of different tasks that may be accomplished by a 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In firmware.

1.3.1 Initialize the Internal Peripherals

At start-up, the firmware initializes the internal operating points of the device. These 
include, but are not limited to:

• switching frequency, phase shift, maximum duty cycle

• output voltage set point

• compensation parameters

• protection peripherals (overvoltage, undervoltage etc.)

This action is accomplished by writing specific values into the corresponding registers.

1.3.2 Handle Protection Events

Most integrated analog protection functions can interrupt the main program execution. 
This ensures that the product, and more specifically the firmware, can react to external 
events as fast as possible.

1.3.3 Soft-Start Ramp

When the output turns on, the device uses a voltage ramp in order to reach the output 
voltage target. This ramp is managed by the firmware by increasing the internal 
reference (OVCCON) step by step.

1.3.4 Environment Monitoring

The device can continually check its environment by using the internal analog-to-digital 
converter (ADC). It can then use this result to make any operating point adjustments. 
The firmware also handles the GPIO pins’ states.
 2013-2014 Microchip Technology Inc. DS50002113B-page 13
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1.4 GRAPHICAL USER INTERFACE (GUI) ENVIRONMENT

The screen shot below provides a picture of MPLAB X IDE with the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In installed 
(bottom left) and the MCP19110/11/18/19 – Buck Power Supply Graphical User Inter-
face Plug-In project opened (top left). More information is available in Chapter 
2. “Installation and Operation”.

FIGURE 1-2: MCP19110/11/18/19 MPLAB X Plug-In User Interface Overview.

Projects Window Editor Pane

Plug-In View

Note: The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 
Plug-In is preset to be used with the MCP19111 Evaluation Board 
(ADM00397). However, it is possible to use the plug-in with another board.
DS50002113B-page 14  2013-2014 Microchip Technology Inc.
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Chapter 2.  Installation and Operation 
2.1 GETTING STARTED

2.1.1 Required Software

• MPLAB X IDE v2.20 or later

• MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In 
archive. See the MCP19110/11 or MCP19118/19 devices web pages for details. 
The archive contains the MCP19110/11/18/19 plug-in file 
(com-microchip-mplab-mcp1911X-buckpowersupply.nbm)

• MPLAB XC8 C Compiler (v1.33 or later)

2.1.2 Required Hardware

• Microchip PIC programmer/debugger (for example, PICkit 3 or ICD3)

• MCP19111 Evaluation Board (ADM00397) or another board containing an 
MCP19110/11/18/19 and a programming connector

2.1.3 Software Installation

The following steps describe how to install the MCP19110/11/18/19 – Buck Power 
Supply Graphical User Interface Plug-In.

1. If MPLAB X IDE is already installed, go to Step 2. If not, download MPLAB X 
IDE (free) from www.microchip.com/mplabx and follow the MPLAB X IDE 
installation instructions.

2. If an XC8-compatible C-compiler is already installed in MPLAB X IDE, go to Step 
3. If not, you can download a free version of Microchip's XC8 from 
www.microchip.com/mplabxc. The XC8 user’s guide, installation instructions 
and download links are available on this page.

3. Download the MCP19110/11/18/19 – Buck Power Supply Graphical User 
Interface Plug-In Archive (*.zip) from www.microchip.com/mcp19111 under 
“Documentation & Software”.

4. Unzip the MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 
Plug-In archive, which contains the 
com-microchip-mplab-mcp1911X-buckpowersupply.nbm plug-in file.

Note: If you are not using the standard MCP19111 Evaluation Board (ADM00397), 
then some of the predefined features may not be compatible with your 
configuration. The schematic of the MCP19111 Evaluation Board, as well as 
“MCP19111 Evaluation Board User’s Guide” (DS52109), are available on 
the Microchip website. From the Microchip website, please search for the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In 
product page and review the software tools.
 2013-2014 Microchip Technology Inc. DS50002113B-page 15
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5. The plug-in file must be installed in MPLAB X IDE. To install it, open MPLAB X 
IDE. From the menu bar, select Tools > Plugins.

FIGURE 2-1: Starting the Plug-In Installation.

6. This opens a new Plugins window. Select the Downloaded tab and click on the 
Add Plugins button.

FIGURE 2-2: The Plugins Window.
DS50002113B-page 16  2013-2014 Microchip Technology Inc.
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7. Locate the com-microchip-mplab-mcp1911X-buckpowersupply.nbm 
file that was downloaded in the archive and click on Open. Then click on the 
Install button on the bottom left side of the window.

FIGURE 2-3: Opening and Launching the Plug-In Installation File.

8. This opens the “Plugin Installer” window. Click on Next to continue.

FIGURE 2-4: The Plugin Installer Window.
 2013-2014 Microchip Technology Inc. DS50002113B-page 17



MCP19110/11/18/19 – Buck Power Supply Graphical User Interface User’s Guide
9. Review and accept the License Agreement by checking the I accept the terms 
in all of the license agreements check box, then click on Install.

FIGURE 2-5: Plug-In License Agreement.

10. If a window opens indicating that the MCP19110/11/18/19 plug-in is not signed, 
click on Continue. 

FIGURE 2-6: Validation Warning Message.
DS50002113B-page 18  2013-2014 Microchip Technology Inc.
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11. Once the installation completes, select Finish to close the Plugin Installer 
window. The installation requires the MPLAB X IDE to be restarted. Choose the 
option that best fits your needs. When done, the MCP19110/11/18/19 – Buck 
Power Supply Graphical User Interface Plug-In should be visible as displayed in 
Figure 2-8.

FIGURE 2-7: Plug-In Installation Complete.

Note: The MPLAB X IDE allows the windows to be configured in different ways. 
To adjust placement or orientation, use your mouse to click and hold the 
tabs you want to move, then drag them to the location you want.
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FIGURE 2-8: MCP19110/11/18/19 MPLAB X Plug-In Tab After Installation.

The plug-in needs an MCP1911X project to work on in order to be enabled. Figure 2-8 
shows the MCP19110/11/18/19 Plug-In GUI when no project is currently opened. If there 
are no MCP1911X projects, the plug-in can create a new MCP1911X project using the 
Create New Project button. This button will open a window that allows choosing the 
new project folder location. The MCP1911X project folder can be placed in any location. 
Once the project is created, it will be automatically opened by MPLAB X IDE.

To update an existing project, go to File>Open Project. In the Open Project window that 
opens, browse to the location of your project and click on the Open Project button, as 
shown in Figure 2-9.

FIGURE 2-9: The Open Project Window.

Note: The plug-in will be enabled if the project is compatible with the opened 
plug-in.
DS50002113B-page 20  2013-2014 Microchip Technology Inc.
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FIGURE 2-10: Displaying the Plug-In.

Note 1: If multiple projects are opened on MPLAB X IDE, the plug-in will work on 
the project selected as “Main Project”. The main project can be changed 
by right clicking on the desired project, then choosing “Set as Main 
Project” from the Projects view.

2: If the plug-in is not visible in MPLAB X IDE, it can be displayed using the 
MPLAB X IDE menu, as shown in Figure 2-10.
 2013-2014 Microchip Technology Inc. DS50002113B-page 21
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2.2 PROJECT CONFIGURATION
To display the project properties, right click on the project name inside the Projects view 
and select Properties, as shown in Figure 2-11. While the provided project should 
already be correctly configured to ensure proper hardware and software configuration, 
please ensure that the correct hardware tool (PICkit 3 or ICD3) and C-compiler (XC8) 
are highlighted in the Hardware Tool and Compiler Toolchain windows, respectively. 
Figure 2-13 shows an example of how to select these tools. This section describes a 
list of settings that must be checked before beginning to use the tools.

FIGURE 2-11: Selecting Properties in the Projects View.

FIGURE 2-12: PICkit 3.
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FIGURE 2-13: Project Properties View.

There are additional important properties of the MCP1911X project shown in the 
following screen shots. Please note that each device’s version has its own set of 
properties. Please ensure to set the properties for the correct targeted device. For 
instance, to set the properties of an MCP19110 device, follow the “Conf:[MCP19110]” 
branch on the tree view from the project properties window (Figure 2-13).

• The “Freeze Peripherals” option must be disabled to use the debug mode (to 
disable it, deselect the check box).

FIGURE 2-14: Project Properties – Freeze Peripherals.

• The programmer should not power the device. Therefore, please ensure the 
“Power target circuits from PICkit3” option under the Power option category is not 
enabled. The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 
Plug-In shall be powered by VIN.

FIGURE 2-15: Project Properties – Power Configuration.
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• To use the debug mode, the “Calibrate oscillator” peripheral option under the 
Runtime option category must be disabled.

FIGURE 2-16: Project Properties – Calibrate Oscillator.
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2.3 PLUG-IN FEATURES

At this point, you should be able to set your desired parameters through the GUI (see 
Section 2.4 “GUI Tab Descriptions”). This section describes the actions provided by 
the plug-in and the basic MPLAB X IDE options that allow programming or debugging 
the part.

2.3.1 MCP19110/11/18/19 – Buck Power Supply Graphical User 
Interface Plug-In Description

Figure 2-17 shows the actions provided by the MCP19110/11/18/19 – Buck Power 
Supply Graphical User Interface Plug-In.

FIGURE 2-17: MCP19110/11/18/19 – Buck Power Supply Graphical User 
Interface Plug-In Actions.

The plug-in status label describes if the plug-in has detected an MCP1911X project to 
work on. It also displays the project firmware version. If no projects are detected, the 
plug-in will not be enabled.

The Create New Project button allows creating a new MCP1911X project. Once 
pressed, a window will allow selecting the project folder location. The plug-in will 
automatically open the project and set it as the main project. This button is available at 
any time.

The Profile Selection drop-down menu is used to select the desired profile to act on 
as described below. A profile is a set of firmware parameters that contains the whole 
MCP19110/11/18/19 settings (output voltage, switching frequency, etc.). The user can 
load, create, save, delete, import and export a firmware profile for the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In.

The Load Profile button ( ) will restore all values from the selected profile into the GUI. 
This action will override the user’s current changes if they were not saved. A message 
box will appear to remind this to the user before the current values are replaced.

The Create Profile button ( ) will ask the user for a profile name. When set, the plug-in 
will create the new profile with the current settings from the GUI.

Profile
Selection

Plug-In
Status
Label

Tab Selection Area
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The Save Profile button ( ) is used to store the current data from the GUI into the 
selected profile.

The Delete Profile button ( ) will delete the selected profile. The evaluation board 
profile cannot be removed because it is used as a working starting point profile.

The Import Profile button ( ) allows reading a profile file (.cfg). The plug-in will read 
all the values in the file and will update the values on the GUI.

The Export Profile button ( ) is used to create a file from a profile. This file can be 
imported by another MCP19110/11/18/19 Plug-In installation.

The Open Firmware Folder button ( ) opens the folder containing the compiled 
firmware (commonly called .hex file). This compiled firmware can be used directly to 
program the part.

The Expert Mode button ( ) allows switching the GUI in Expert mode, which enables 
the features described in Section 2.5 “Advanced Mode”.

The Help button ( ) will open a web browser to the MCP19110/11/18/19 – Buck Power 
Supply Graphical User Interface Plug-In official page. This page contains all the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In user’s 
guides and application notes.

The tab selection area contains several tabs displaying the MCP1911X project settings. 
These tabs are described in Section 2.4 “GUI Tab Descriptions”.

2.3.2 MPLAB X IDE Actions

MPLAB X IDE provides standard commands to compile, program or debug the 
MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In. This 
section describes the most common commands.

FIGURE 2-18: MPLAB X IDE Actions.

The Clean and Build button ( ) allows compiling the MCP1911X project. This may 
be useful to verify that the code syntax is still correct after a source code change or to 
verify the memory usage of a firmware. This option is available without a PICkit or ICD 
programmer.

The Program Part and Run button ( ) compiles the project source code, programs 
the part and executes the code. Before programming, ensure that the programmer is 
correctly installed and connected. In addition, the evaluation board must be powered 
with at least 6V input. If this is the first time the programmer has been used, the 
environment may prompt on which programmer you want to use.

The Program Part and Debug button ( ) does the same thing as the Program Part 
and Run but you can additionally control the firmware. If the part is programmed in 
Debug mode, it will not restart automatically after a power-off.

Note: The user cannot modify the default evaluation board profile because it is 
protected.

Note: Before taking the compiled firmware file, make sure it is up-to-date. Use the 
MPLAB X IDE Clean and Build button (see Section 2.3.2 “MPLAB X IDE 
Actions”) to generate a new firmware based on the current GUI settings.
DS50002113B-page 26  2013-2014 Microchip Technology Inc.



Installation and Operation
The Device Selection drop-down menu allows selecting the targeted device: 
MCP19110, MCP19111, MCP19118 or MCP19119. When the MCP19110/18 is 
selected, the Enable pin can move to another available pin because not all 
MCP19111/19 pins are available on the MCP19110/18 and device. This selection 
actually selects a project properties set. The project contains a set of properties for 
each device version, but only one is used depending on the device selection. After a 
device selection, please make sure that the selected project properties are correctly set 
according to Section 2.2 “Project Configuration”.

FIGURE 2-19: Drop-Down Menu Example

The figure below shows a second method which allows selecting the device version by 
right clicking on the project from the Projects view.

FIGURE 2-20: Changing Targeted Device Using Right-Click on Project Example.
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2.4 GUI TAB DESCRIPTIONS

This section shows the GUI tabs provided by the MCP19110/11/18/19 MPLAB X 
Plug-In. These tabs are used to modify the firmware of the MCP1911X project. As soon 
as a new option has been set from the GUI, the firmware will be updated and can be 
directly programmed. Please also refer to the MCP19110/11 or MCP19118/19 data 
sheet for more information on the product configuration.

Placing the cursor over settings controls or labels will give a brief description of what 
these particular settings do. See the example in Figure 2-21.

FIGURE 2-21: Tooltip Text Example.

2.4.1 Parameter Tab

The Parameter tab is used to set the main features of the part, as shown in Figure 2-22.

FIGURE 2-22: The Parameter Tab.
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2.4.1.1 OUTPUT VOLTAGE

The output voltage of the MCP19110/11/18/19 – Buck Power Supply Graphical User 
Interface Plug-In device is user-programmable over the range of 0.5V to 3.6V. The value 
set for “Set Coarse Value” is translated for the OVCCON register, while the value set for 
“Set Fine Value” is translated for the OVFCON register. The OVCCON DAC is an 8-bit 
DAC that coarsely adjusts the output voltage set point. The OVFCON DAC is a 5-bit DAC 
that finely adjusts the output voltage set point. Refer to the Electrical Characteristics table 
in the MCP19110/11 or MCP19118/19 data sheet for more information.

2.4.1.2 INPUT VOLTAGE

The “Input Voltage Ripple” section defines the input capacitance and its equivalent 
series resistance (ESR) necessary to meet the specified input ripple requirement.

2.4.1.3 OUTPUT CURRENT ESTIMATION

The parameters under “Step Load Parameters” are used to define the dynamic 
performance of the system and indicate the amount of output capacitance needed to 
achieve the desired transient response. The MCP19110/11/18/19 control system uses 
an analog peak current mode control. The load step is defined as the load current step 
from high output current to low output current.

The next step requires entering the size of the overshoot desired for this load step. 
Larger load current steps and smaller output voltage overshoot result in larger output 
capacitance and lower ESR to minimize the overshoot leading to a higher system cost.

2.4.1.4 MULTI-PHASE CONFIGURATION 

The “Multi-Phase Configuration” section changes the value loaded into the BUFFCON 
register. The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface 
Plug-In has the ability to operate as shown in Table 2-1.

TABLE 2-1: OPERATION MODES FOR THE MCP19110/11/18/19 – BUCK POWER SUPPLY 
GRAPHICAL USER INTERFACE PLUG-IN

Operation Mode Description

Stand-alone unit The device is configured to run as a stand-alone converter. No external clock or error signals are 
necessary. This is the option that should be used for a single evaluation board.

Multiple output master unit This option is used when the user desires multiple output voltages. In order to do this, the system 
must have multiple MCP19110/11/18/19 devices. When selected, the device is configured as the 
MASTER and its CLOCK is the output on the CLKPIN. The devices configured as slaves use this 
signal for synchronization. All other peripherals remain the same as those for the stand-alone unit.

Multiple output slave unit For this option, the CLKPIN is configured as an input and should be connected to the CLKPIN of the 
multiple output master. All other peripherals remain the same as those for the stand-alone unit. 

Multi-phase master unit This option should be used when the user desires multiple power trains to share the load current. In 
this case, the output of each power train is connected to the same output rail. Like the multiple 
output master, its CLOCK is the output on the CLKPIN. The devices configured as multi-phase 
slaves use this signal for synchronization. The EAPIN is also configured as an output which feeds 
the output of the error amplifier to the multi-phase slave unit for regulation. All other peripherals 
remain the same as those for the stand-alone unit.

Multi-phase slave unit For this option, the CLKPIN is configured as an input pin and should be connected to the CLKPIN of 
the multi-phase master. The EAPIN is configured to be an input pin and should be connected to the 
output of the multi-phase master’s amplifier. Since the master and slave error amplifier offsets are 
slightly different from part to part, the error input signal gain of the multi-phase slave can be dynam-
ically changed so that the multiple power trains will share the load current equally. The error input 
signal gain of the multi-phase slave will load the values into the SLVGNCON register and add gain 
to the error amplifier signal provided by the multi-phase master. The available gain range is from 
-3.2 dB to 3.0 dB. All other peripherals remain the same as those for the stand-alone unit.
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2.4.1.5 SWITCHING FREQUENCY

The switching frequency of the MCP19110/11/18/19 – Buck Power Supply Graphical 
User Interface Plug-In is generated by using a single edge of the 8 MHz internal clock. 
The MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In 
switching frequency is set by configuring the PR2 register. The programmable range of 
the switching frequency is from 100 kHz to 1.6 MHz. The maximum allowable HDRV 
duty cycle is adjustable and is controlled by the PWMRL register. The available 
switching frequencies below 1.6 MHz are defined as FSW = 8 MHz/N, where N is an 
integer number between 5 and 80.

The phase of the MCP19110/11/18/19 slave devices may be shifted from the MASTER 
clock through the PWMPHL register. The GUI can be used to configure this delay for 
a slave device.

The switching frequency of the converter determines the efficiency, the transient 
response, the size and the cost of the design. The switching frequency should be 
carefully evaluated to optimize the design to the performance goals.

2.4.1.6 DEAD TIME DELAY

In the MCP19110/11/18/19 – Buck Power Supply Graphical User Interface Plug-In, the 
dead time is adjustable from 4 ns to 64 ns for the low side and from 11 ns to 71 ns for 
the high side, in 4 ns steps. The values for tDEAD-1 and tDEAD-2 do not need to be the 
same. The desired drive signal dead time is configured through the GUI by configuring 
the DEADCON register, as shown in Figure 2-23.

FIGURE 2-23: Dead Time Description.

2.4.1.7 START-UP BEHAVIOR

The Soft Start duration control on TMR1L and TMR1H registers to achieve the soft start 
ramp time. Each time the TMR1 timer overflows, the OVCCON will increase its value, 
so the output voltage set point will be increased in 15.8 mV steps. Soft Stop is 
implemented the same way.

If a start-up pin is used, the selected pin will be set by using the V_NUM_EN_PIN from 
the V_MCP1911X.h definition. When a start-up pin is defined and enabled, the 
selected pin will automatically be configured as an input and the internal pull-up will be 
enabled. By default, the start-up pin is connected to the BT1 button of the MCP19111 
Evaluation Board (ADM00397). If the start-up pin is enabled, the part will start switching 
only after pressing the BT1 button. Pressing the button while the part is switching will 
stop it.

tDEAD-1

tDEAD-2

tDEAD-1

HDRV

LDRV
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2.4.2 Components Tab

The Components tab is used to set the component of a system in order to compute 
the best compensation setting and the efficiency of the system. This tab contains a 
button allowing to load the value of the MCP19111 Evaluation Board (ADM00397) 
components. A second button allows loading the best component value depending on 
the parameters set in the Parameter tab. They represent component values that meet 
the design goals. These recommended values are displayed on the right of the current 
values. See Figure 2-24 below.

Microchip’s MCP87050 and MCP87018 MOSFETs were used for the high-side and 
low-side switches. The MOSFET’s ON resistance (RDSON) and gate charge are both 
critical parameters for design analysis. The low-side MOSFET body diode 
characteristics are also a key parameter for estimating the efficiency of the converter. 
Refer to the MOSFETs’ data sheets for more information.

The diode conduction time is the estimated amount of time when the current is flowing 
through the low-side switch body diode. This time can be adjusted by using the 
MCP19110/11/18/19 dead time adjust setting. The inductor DC resistance and the ESR 
of the input and output capacitors are also used for efficiency and control system 
calculations. Refer to the component data sheets for more information on these values.

FIGURE 2-24: The Components Tab.
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2.4.3 Efficiency Tab

The Efficiency tab represents the calculated efficiency using the component 
parameters. A good idea is to vary the critical values to see the effect on the system 
efficiency. For example, increasing the switching frequency results in lower efficiency. 
Optimizing the high-side MOSFET results in higher efficiency for specific operating 
conditions. Lower-resistance high-side MOSFETs do not always result in the highest 
efficiency. If the switching losses are much larger than the conduction losses for the 
high-side MOSFET, a MOSFET with higher RDSON and lower gate charge or capacitance 
may be a better choice for the operating conditions of interest. See Figure 2-25.

FIGURE 2-25: The Efficiency Tab.
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2.4.4 Protection Tab 

The Protection tab is used to set the protections features, as shown in Figure 2-26.

FIGURE 2-26: The Protection Tab.

2.4.4.1 OUTPUT UNDERVOLTAGE AND OVERVOLTAGE

The “Output Voltage Protection” value acts on the OUVCON and OOVCON registers 
for the desired threshold. These registers hold the digital values that set the DAC 
voltage levels at which the output undervoltage and overvoltage are detected. The 
ABECON register is used to activate or deactivate the protection. The available range 
for these settings is from 0.0V to 3.84V. When an output overvoltage or output 
undervoltage occurs, an interrupt flag is set, allowing virtually any action to be taken 
through the firmware. The GUI does provide the option to disable the output if either an 
undervoltage or overvoltage event occurs.

2.4.4.2 OUTPUT OVERCURRENT

The GUI acts on the OCCON register. This register contains the digital value 
(OOC<4:0>) that sets the DAC voltage level, at which the output overcurrent state is 
detected. The voltage drop across the high-side power MOSFET is measured and 
compared to the OOC<4:0> value. Leading edge blanking is applied to this current 
measurement. The amount of leading edge blanking time is controlled by the 
OCLEB<1:0> bits in the OCCON register. The overcurrent Enable bit is also contained 
in the OCCON register. The available range for this setting will depend on the high-side 
RDSON value but the GUI will automatically scale the settings based on the RDSON 
value. When an overcurrent event is detected, the high-side drive will immediately turn 
off and skip the next clock cycle. An internal flag will also be set, so other desired 
actions may be taken through the firmware.
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2.4.4.3 INPUT UNDERVOLTAGE LOCKOUT

The GUI is used to configure the VINLVL register for input undervoltage lockout (UVLO) 
protection. This register sets the DAC voltage level, which sets the input undervoltage 
lockout threshold. When the input voltage is above this value, the MCP19110/11/18/19 – 
Buck Power Supply Graphical User Interface Plug-In is allowed to turn on. The UVLO 
Enable bit is also contained in this register. The available range for this setting is 4V to 32V.

2.4.5 Compensation Tab

The Compensation tab is used to set the compensation parameters. This tab shows the 
tools/elements that are used to design the system's analog control loop. The Gain and 
Zero Frequency drop-down menus from the “Compensation” section set the position of 
the zero used to compensate the control system. Changes in the system dynamic 
performance result from changing the location of the system zero and gain. The next 
rows show the slope compensation needed for peak current mode control. Increasing the 
level of slope compensation reduces the influence of the current feedback relative to the 
influence of the voltage feedback. Over-compensation can introduce instability; 
under-compensation can introduce voltage ripple. The “Current sense gain” and “Current 
sense DC gain” cells are used to set the gain of the current sense signal. The calculated 
system crossover frequency and phase margin are also displayed. The higher the 
crossover frequency, the faster the system responds to transients. Higher switching 
frequency and lower inductance enable a higher crossover frequency while sacrificing 
efficiency. Phase margin greater than 45 degrees is recommended. See Figure 2-27.

FIGURE 2-27: The Compensation Tab.
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2.4.5.1 COMPENSATION

The “Compensation” values set the CMPZCON register. This register contains the bits 
that set the compensation gain (CMPZG<3:0>) and the zero frequency (CMPZF<3:0>). 
The available range of values for the zero frequency is from 1500 Hz to 35300 Hz, 
while the gain is adjustable from 36.15 dB to 0 dB.

The SLPCRCON register controls the slope compensation ramp that is subtracted from 
the error amplifier output. The four SLPS <3:0> bits control the slew rate of the ramp. 
The four SLPG<3:0> bits control the amplitude of the ramp signal. The available 
amplitude range is from 0.017 VPK-PK to 1.250 VPK-PK, as measured for a 50% duty 
cycle waveform.

The current is measured across the inductor by using a resistor-capacitor (RC) in 
parallel and extracting the inductor current information from the voltage across the 
capacitor. This very small voltage, plus the ripple, is amplified by the current gain 
amplifier. The amount of gain is controlled by the CSGSCON register. The range of the 
gain that can be set is from 0 dB to 22.5 dB and has a step size of 1.5 dB.

2.4.5.2 COMPUTED RECOMMENDED VALUES

There are two automated features to complete the Compensation tab values. The 
Load Eval Board Components and Compensation feature sets this tab to the 
default values that are standard on the MCP19111 Evaluation Board (ADM00397). 
This feature is used as a reset to restore the analyzer back to the original evaluation 
board component values. The Load Recommended Components and 
Compensation feature automatically fills in the tab with the calculated values. This 
feature is used to evaluate changes in key parameters quickly (such as switching 
frequency, inductance, output capacitance and ESR, MOSFET parameters, etc.).

2.4.5.3 BODE PLOT OF COMPENSATED SYSTEM

A bode plot displays the system gain and phase curve over frequency. Crossover, 
phase margin and gain margin are also displayed. The curves and the data are updated 
automatically.

The Keep Data button allows keeping the current curves and data. This allows 
changing any parameter and comparing the different performance to the kept curves 
and data. 

The Restore Data button will restore the kept data in place of the current GUI value.

The Clear Data button will remove the displayed kept curves and data. After pressing 
this button, there is no more kept data to restore.

Note: The Restore Data and Clear Data buttons are enabled only after the Keep 
Data button has been used.
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2.5 ADVANCED MODE

The Advanced mode can be activated using the Export Mode button ( ) on the plug-in. 
When this mode is enabled, the following changes appear:

• Apart from the common tabs, the MCP19110/11/18/19 – Buck Power Supply 
Graphical User Interface Plug-In GUI has a new Bench Test tab allowing certain 
peripherals to be disabled or output internal signals using the test multiplexer of 
the IC.

• Two new toolbar buttons will be displayed.

2.5.1 New MCP19110/11/18/19 – Buck Power Supply Graphical User 
Interface Plug-In Actions for Advanced Mode

FIGURE 2-28: Actions for Advanced Mode.

The Refresh GUI button ( ) is used to refresh the GUI values from the project sources. 
This can be used if the project source files are modified externally to the GUI.

The Update Values in Debug Mode button ( ) allows the part to be updated with the 
latest GUI values while it is still running. This option is only available when the part is 
running in Debug mode. For some values, such as the output voltage, this function 
does not directly write into the corresponding register but rather to an intermediate 
variable. This variable is then used by the main program to change the output voltage 
using a specified ramp. Another important point is that this feature only acts on the 
values specified in the Parameter, Protection, Compensation and Bench test (in 
Advanced mode) tabs.
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2.5.2 Bench Test Tab

FIGURE 2-29: The Bench Test Tab.

The Advanced mode displays a new tab on the MCP19110/11/18/19 – Buck Power 
Supply Graphical User Interface Plug-In, the Bench Test tab, shown in Figure 2-29.

The parameters under the “Others” section control the VZCCON register and the 
BUFFCON - ASEL register. The ASEL bits are used to select a desired internal signal 
and connect it to the GPA0 pin as an analog output. It also requires that the BNCHEN 
check box under the “Peripherals Activation” section is enabled.

The check boxes under the “Peripherals Activation” section are used to enable or 
disable the peripherals that cannot be controlled directly from the other tabs.
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2.6 HOW CAN THE CODE BE MODIFIED?

Before editing the code, it is useful to understand how the plug-in interacts with the 
project source to avoid conflicts.

The GUI plug-in writes to the V_MCP1911X.h file. This file contains definitions where 
the name starts with a “V_” and defines a byte value.

Example: #define V_TMR1 0x99

In order to maintain the functionality of the firmware, these types of definitions cannot 
be modified and they must keep their original name. The settings displayed by the GUI 
are saved/read directly to/from the project sources after any changes in the GUI 
parameters.

This file also generates some conditional definitions in order to activate/deactivate 
several firmware features. Example: in V_MCP1911X.h:

If V_NUM_EN_PIN  PIN_DISABLED, the EN_PIN_EN will not be defined.

Then in main.c:

If the user inserts code between the #ifdef EN_PIN_EN and #endif, the code may 
not be included at the compilation. Below is a summary of the project modification 
permissions to keep the plug-in working with the project.

• New source files can be added.

• Existing source files can be removed or modified, except for V_MCP1911X.h, 
which cannot be removed. If some code is removed from the existing file, some 
features provided by the GUI may not respond correctly.

• The project name can be modified.

• The project folder name can be modified.

#if (V_NUM_EN_PIN < PIN_DISABLED)

#define EN_PIN_EN    0X01

#ifdef EN_PIN_EN

    EN_PIN_WPU = 1; //weak pull-up enable

    EN_PIN_IO = 1; //input state

    EN_PIN = 0;

    EN_PIN_INT_EN = 1; //interrupt enable

#endif
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NOTES:
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